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Introduction 

This manual contains guidelines for creating component group “microsites” in SAA’s Web content 

management system, Drupal. In addition to being a resource for volunteer member leaders, the purpose 

of this document is to foster coordination between and among committees, sections, roundtables, and 

the SAA staff in order to develop a highly informative and easy-to-use website for the entire Society. 

Auxiliary Group Websites 
SAA recognizes that component groups may have needs that cannot be met within the Drupal microsite 

environment. When this is the case, a component group may make use of other social media tools to 

accomplish its communication objectives. Component groups wishing to create or populate an external 

web resource (including a social media account) are welcome to do so. Such sites/accounts must adhere 

to guidelines in the Guide for SAA Leaders. It is a best practice to list/link to all auxiliary sites on the 

group’s microsite. 

 

Please email SAA Headquarters at saahq@archivists.org for additional information. 

Basics 

Assignment of Editing Privileges for Group Leaders 
All group leaders (for most groups, this is the steering committee) are given access to edit the microsite 

by default. We recommend that groups designate one or two members to act as “web liaison.” 

SAA staff manages group rosters in the member database, which controls permissions to access the 

microsites. Group leaders should ensure that they provide updated roster information to SAA staff. 

Introduction to “Nodes” and “Content Types” 
Every discrete piece of content administered in Drupal is a node. The term “node” is simply an 

abstraction used to refer to any record, regardless of type. Content types are configurations of nodes 

for specific purposes (e.g., “Page,” “News Item,” or “Meeting Minutes”). 

Getting Started 

Once your group homepage is created by the SAA staff and leader roles are assigned in the member 

database, you’re ready to start configuring your microsite for use. If you’ve never accessed your site 

before and a public link is not yet active in the general navigation menu, locate your microsite as 

follows: 

1. Log into to Drupal via your personal SAA Profile; 

2. Click “My Account” in the top right corner of the screen; 

3. Click on the appropriate link under your list of groups. 

mailto:saahq@archivists.org
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If you do not see a link, you may need to have your leader role activated by SAA staff. Email Matt Black 

at mblack@archivists.org for additional assistance. 

Your Group Homepage 

 

Figure 1. Example of a component group homepage, as viewed by the Group Officer. Display of “View” and “Edit” 
tabs and administrator menu items is contingent upon user permissions. 

 

Your microsite consists of:  

1) The group name;  

2) Navigation links, automatically generated; 

3) Introductory/welcome text (Full Group Description);  

mailto:mblack@archivists.org
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4) A “Recent News & Announcements” feed that displays selected content in reverse chronological 

order;  

5) Related Group Content box. See Hide Automatic Display of Group Nodes (“Auto-links”) below. 

Note that this menu is paginated, and you may need to use the page controls at the bottom of 

the box to find your content. 

6) An administrator menu;  

7) Group Menus (custom); and 

8) Links to Leader Resources (shows only to logged-in group leaders). 

 

(Figure 1.) 

 

Editing the group homepage 

Group Officers may edit introductory/welcome text published on the homepage and access other 

administrative settings associated with the entire microsite by clicking on the “Edit” tab at the top of the 

group homepage. 

Theme: Use of the “SAA Theme” is strongly recommended. 

Description: You may leave this field as is. 

Full Group Description: The contents of this field correspond to your introductory/welcome 

message. Enter content to greet your visitors. We recommend a succinct greeting because 

extensive text may push the other content further down the page. 

Hide Automatic Display of Group Nodes: See below. 

Header/Footer: The header and footer fields are intended for creating custom page templates 

using the “Blank Theme” option. It is recommended that these fields be left blank. 

Comment Settings: Disabled by default (recommended). 

File Attachments: Generally, files are attached to other microsite nodes. However, they are also 

supported on the group homepage if desired. 

Hide Automatic Display of Group Nodes (“Auto-links”) 

Links to group content appear at the bottom of all nodes in your microsite. They are arranged in reverse 

chronological order by content type and cannot be rearranged. To give Group Officers more flexibility in 

controlling microsite navigation, the checkbox labeled “Hide Automatic Display of Group Nodes” places 

these links in a gray box that is visible only to group administrators. (Figure 2.) If you decide to use this 

option, customized menus should be created to direct users to your content. 

General Functions 

The following functions are common to many group content types: 
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Add Node 
Click the “add” links in the right-hand administrator menu to create nodes according to content type. 

Display of these links is contingent upon your designated permissions. 

Edit Node 
Authenticated users with the requisite permissions will see “View” and “Edit” tabs at the top of nodes 

they are authorized to edit. Click the Edit tab to access the editing tools. 

Revisions 
Every time you edit and save a node, a copy of the old version is automatically recorded. You may also 

enter a log message for internal reference purposes. Prior versions, if applicable, may be accessed via 

the “Revisions” tab. Please note, however, that prior versions of the group homepage are not 

maintained. 

 
Figure 2. group homepage with automatic display of group nodes (“auto-links”) hidden. 
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Figure 3. “Insert/edit image” icon and dialog box. 

Rich-text Formatting 
Most content types feature at least one long-text field with a WYSIWYG1 formatting toolbar (Figure 3). 

This toolbar may be used for relatively simple formatting such as boldface, italic, bullet lists, numbered 

lists, indentation, and editing of static hyperlinks.  

Tips for Using the Formatting Toolbar Effectively:  

 When pasting text from Word, be sure to use the “Paste from Word” icon to strip out 

incompatible code. 

 Use the eraser icon to Remove Formatting applied in external applications. Note: This 

may require reapplication of your desired formatting. 

 Use the Format drop-down menu to apply standardized styles (e.g., H2, H3, etc.) for 

headers and sub-headers. 

Input Format:  Two editing modes may be used: 

1. Filtered HTML (recommended) is the default that displays the toolbar. 

2. Full HTML enables you to edit your markup code directly.  Tip: Nodes edited in Full 

HTML must be saved in that mode for some tags to render. Changing input formats will 

“filter” them out. 

Inserting and Editing Images 
The formatting toolbar features an icon that allows you to easily insert and edit inline images. The icon 

looks like a tree (Figure 3). Images are inserted at your cursor’s location. Clicking on the icon opens a 

                                                           
1 “What you see is what you get” (WYSIWYG). 
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dialog box in which you can set the image URL, description, alignment, dimensions, border, and 

vertical/horizontal space to appear around the image (i.e., the gutter). 

To the right of the Image URL field is a “Browse” icon. Clicking this icon opens another dialog box that 

displays your individual user folder in Drupal. You may use the “Upload” link to upload image files from 

your local drive. Uploaded files may be highlighted and inserted into your node by clicking on the 

“Insert” link. Upon returning to the “Insert/edit image” dialog box, you will notice that the Image URL 

field is now populated with the absolute path to your image in Drupal. Click again on the “Insert” button 

to return to your node edit screen. You will now see your image in the WYSIWYG text field. 

Promote to Group Front Page and SAA News Feed 
Links to News Items, Newsletters, Reports, and Meetings nodes are automatically displayed in reverse 

chronological order on your group homepage and on the Global SAA Newsfeed at 

http://www2.archivists.org/newsfeed if and when the checkbox on the node edit screen is checked 

(default). Items can also be designated as “sticky” under Publishing Options, found at the bottom of the 

node edit screen. Sticky nodes will remain at the top of your homepage feed above other more recently 

created content. 

 
Figure 4. The “Public” checkbox on the node edit screen. 

 

Administering Public vs. Private Content 
 

 

Under the “Groups” header on the node edit screen is a checkbox labeled “Public” (Figure 4). Check this 

box to make the node appear to users outside of your group leadership.  

The SAA website is designed to be a public site and to make materials accessible and 

discoverable. Content and files uploaded to the site should not contain important confidential 

information. 

If your group requires a secure online environment in which to collaborate, we recommend Google 

Drive or a similar site with rigorous security protocols in place. The procedures below allow users 

to “hide” some content from the general public, but these are not secure from hackers or malicious 

attacks. 

http://www2.archivists.org/newsfeed
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There are two methods to administer private content—i.e., nodes viewable only by your group leaders 

and staff: 

“Weak” Method:  If you leave unchecked the checkbox labeled “Public,” links to the node will 

not display in your News Feed or in the auto-links block for public users. Such links will appear 

for your group leaders and for staff. There are two limitations to this method: 

 Static links embedded in other group nodes or on external sites are unaffected by the 

“Public” checkbox setting. 

 Actual access to the node is not restricted. If a public user browses to your private node 

via a static link or by typing the URL directly into her browser, the content will display. 

Therefore, confidential information should not be managed via this method. 

“Strong” Method:  All group content types have been configured with per-node access control. 

Group Officers have permission to use these settings, which are managed via the “Access 

control” tab displayed to the right of the “Revisions” tab (Figure 5). 

This screen allows Group Officers to override the standard node permissions. These controls 

supersede the Public checkbox setting and should be used as follows. (Note: Numbers below 

correspond to labels in Figure 5.) 

1. Under “View any content,” uncheck anonymous user and authenticated user. This 

removes the default view permission granted to all public users. 

2. Under “View any content,” check group contributor, group editor, and group officer. 

This re-grants view permission to your group leaders. (Note: You may ignore group 

manager. That role is not used.) 

3. If you wish to grant view permission only to SAA members, check the saa member role 

under “View any content.” 

4. Uncheck anonymous user and authenticated user under “View own content.” 

5. DO NOT ALTER any settings labeled “Edit * content” or “Delete * content.” Changing 

these controls risks unauthorized modification to and/or deletion of your content! 
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Figure 5. The Access Control screen.  

 

File Attachments 
Use this feature to upload and display file attachments with the node. 

Comment Settings 
Specify whether authenticated users may read and/or add Comments to the node. 
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Content Type Descriptions 

Group Menus 
Group Officers can create and edit any number of Group Menus, each of which has its own name and 

any number of sortable links. Group Menus themselves may also be sorted via the Node Weight control 

on the menu’s Edit tab. Smaller values are considered lighter and will appear above heavier items. 

Group menus display in the right-hand margin of your microsite and may be edited by clicking on the 

respective links under “Group Menu” in the auto-links block. 

SAA staff will work with group leaders to configure a core menu with links to information about the 

group maintained in the member database and elsewhere (e.g., leader rosters, group member directory, 

email discussion list(s), etc.) We strongly discourage groups from duplicating such information on static 

nodes in the microsites. Please contact Matt Black at mblack@archivists.org for assistance. 

Group News Items 
Group News Items are designed to support miscellaneous announcements and updates that you want to 

share with the public. These may include calls for newsletter submissions, calls for nominations, etc. 

Group News Items may be added to your homepage feed. News items consist of a Title, a Short 

Description that displays on the group homepage feed (if applicable), a rich-text Content field, Links, 

and File attachments. 

Group Pages 
Group Pages are a generic content type for permanent or semi-permanent nodes such as Section and 

Roundtable bylaws, editorial guidelines for newsletter submissions, etc. Group Pages consist of a Title, a 

rich-text Body field, and File attachments.  

Group Pages may not be added to your homepage feed. Group Pages should not be used to duplicate 

information that is maintained by staff in the member database or elsewhere in Drupal—e.g., leader 

rosters, member rosters, SAA Governance Manual content, etc. Rather, staff will work with group 

leaders to configure custom Group Menus to link to this content as needed. 

Group Newsletters 
Group Newsletters consist of a Title, a Short Description that displays on the group homepage feed  

(if applicable), a rich-text Body field, and File attachments. Group Newsletters may be added to your 

homepage feed.  

Group Reports 
Group Reports consist of a Title, a Short Description that displays on the group homepage feed  

(if applicable), a rich-text Body field, and File attachments. Group Reports may be added to your 

homepage feed.  

mailto:mblack@archivists.org
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Group Meetings 
Group Meetings consist of a Meeting Name, Location fields (e.g.,  Location Name, Contact Name, 

Address, etc.), Meeting Date(s), a Short Description that displays on the group homepage feed  (if 

applicable), a rich-text Description, a Referenced Meeting Agenda pointer, a Referenced Group 

Minutes pointer, and File attachments. Group Meetings may be added to your homepage feed. 

Group Meetings provide a mechanism to manage and display structured relationships with content that 

is related to the meeting. For example, Meeting Agendas may be published as formatted text in the 

Description field, as a File attachment, or as a hierarchical set of child nodes. Use of the child Content 

Types is more complex but allows for granular content settings (e.g., Comments, etc.) 

Meeting Agendas 

Meeting Agendas consist of an Agenda Name, a rich-text Introduction field, a Referenced Group 

Meeting (parent node) pointer, and Referenced Agenda Item (child node) pointers. The meeting 

agenda content type is configured to dynamically display hyperlinks to constituent agenda items. 

Agenda Items 

Agenda Items consist of an Item Name, a plain-text Presenter field, a rich-text Abstract 

field, a Referenced Meeting Agenda (parent node) pointer, a Node Weight field that 

controls sorting of the agenda items within the Agenda, and File attachments. There is also 

a rich-text Prefatory Text field that you may use to specify sub-headers (e.g., Old Business, 

New Business, etc.) that you want to display on the Meeting Agenda. 

Meeting Minutes 

Meeting Minutes consist of a Title, a rich-text Body field, a Referenced Group Meeting (parent 

node) pointer, and File attachments. Links to referenced meeting minutes are dynamically displayed 

on the Group Meeting node. 

 


